
 
HomeSeer Z-Seer™ Installation and Use Guide 
 
This document contains important information that is specific to the use of the HomeSeer’s Z-
Seer Z-Wave diagnostics software with HomeSeer software 

 

Introduction 

Z-Seer (tm) is a Z-Wave installation and analysis tool designed to assist the installer or home 
owner with their Z-Wave system. The application works with HomeSeer to gather information 
about your devices, and display this information in a more intuitive manner. Some features of 
this tool include: 

• Ability to graphically display all of your devices. All devices are labeled using the names 
as assigned in HomeSeer 

• All connections to neighbor nodes are displayed, which shows how commands are being 
routed 

• Tests connectivity between nodes and displays the total time it takes to send and receive 
data packets 

• Displays good and bad packet counts to determine nodes with poor connectivity 
• Allows for optimizing single nodes, or the entire Z-Wave network 
• Filter options allow for displaying a subset of the total number of nodes to determine 

which nodes may be isolated or have poor connectivity 
• Reports can be generated for printing 

View the Getting Started topic for more information. 

Getting Started 

In order to run the Z-Seer Z-Wave analyzer tool you need to have HomeSeer 2.1.148 or later 
loaded and working properly. You also need the HomeSeer Z-Troller™ Z-Wave computer 
interface. This version of the application supports the Z-Troller only. Special firmware in the Z-
Troller is what allows this tool access to specific information such as Z-Wave routing tables. 

The application will refer to Nodes and Devices interchangeably. HomeSeer references Z-Wave 
items as devices, this application references them as Nodes. A node is simply a single Z-Wave 
end point. It could be a single device such as a wall switch or lamp module. It could also be a 
single piece of hardware that may contain multiple nodes. 

The following steps will get you started with the software: 

1. Start HomeSeer, make sure your Z-Troller is working properly and you have already 
added some Z-Wave devices 

2. Start the Z-Seer application. When it starts, it will connect to HomeSeer and retrieve 
information about your devices and display them on the screen.  

3. You may click on a device and drag it to better view your devices. Each device is labeled 
with its name and location as set in HomeSeer.  

4. It may help to drag your devices into groups based on the rooms they are in. 



5. Hover your mouse over a device to display a tool tip with the full Location-Name of the 
device, as well as the Z-Wave node ID. The Z-Wave Node ID is a unique number in the 
range of 1 to 232 which is assigned to the device when you added it to your system. Node 
1 is normally the controller itself and will not be displayed. 

6. Hovering over a device will also show you which devices are neighbors for that device. 
All neighbors will be turned green. All non-neighbors will not change color. 

7. Hovering over the bar graph at the right will display the total number of neighbors for 
this node. The bar graph will display green if more than 20% of the nodes are neighbors. 
It will turn yellow if less than 20% are neighbors, and red if less than 10% are neighbors. 

8. At the bottom of the screen there is an Optimize button. Click this button to force all 
nodes to re-discover their neighbors. This is useful if you move a Z-Wave device to a 
new location, or remove a device. 

9. Also at the bottom of the screen is a Test All button. This will perform a packet test on all 
your nodes and display the results on each node. 

10. Right clicking on a node will display a menu where you can select Test Node which 
allows you optimize the specific node. 

11. After running some tests and gathering results, read the Analyzing Results section to see 
what the results are telling you. 

 

Test Node 

To test an individual node, right click on the node in the main display. A menu will display, 
select "Test Node". This displays a dialog where you can test this specific node. The following 
settings are available: 

• Number of packets to send 
Enter the number of packets you want to send to this node. The default is 10. If the node 
is not responding, click Cancel to stop the test 

When you are ready to test the node, click the Start button. Packets will be sent to the node and a 
timer will time the operation. When completed, statistics will be displayed which show the total 
number of packets sent, how many were lost, and the total time it took to complete the operation. 



The time is displayed as: 

minutes:seconds:10th of a second 

To test all nodes at once, click on the Test All button on the main screen. Nodes that got to sleep 
(such as battery powered sensors) will fail the test since they are most likely asleep. Right click 
on these nodes and select "Exclude from Test All". This keep Z-Seer from testing these devices. 
If you wish to test them, you need them to stay awake. Refer to the instructions for the device to 
see how to keep it awake. The ZIR000 motion sensor will stay awake for 10 minutes after the 
batteries are first inserted. Remove and replace the batteries to keep it awake while you run a test 
on it. 

 

This node shows a total test time of .85 seconds, with 10 good packets and 0 bad packets. 

Filters 

Filters allow you to display only a subset of all your Z-Wave nodes. To enable a filter, select 
"Filter" from the View menu. The following filters are available: 

• Only show nodes with Exactly/Less Than/More Than X number of nodes 
When set to "Exactly", only nodes with the specified number of neighbors is displayed 
When set to "Less Than", only nodes with less than the specified number of neighbors is 
displayed 
When set to "More Than", only nodes with mode than the specified number of neighbors 
is displayed 

• Hide nodes with No Errors 
Hides nodes that are not showing any errors. Note that you have to first test all nodes 
using the Test Node function. 

 



Options 

Select Options from the Edit menu to adjust program options. The following options are 
available: 

• Show connections between nodes 
Enabling this option will display connection lines between nodes that are neighbors. 
Nodes that see each other are colored blue. Connections that are one way (only one node 
sees the other) are colored red. Battery powered devices such as motion sensors typically 
show red lines as they are not seen by other nodes since they don't participate in packet 
routing. 

Reports 

Reports allow you to organize test results in a format that may be printed for later reference. 
Select "Reports" from the View menu. The following information is displayed on all reports: 

• Device Location 
• Device Name 
• Z-Wave node ID 
• Total time to run the packet test 
• Total number of good packets from the packet test 
• Total number of bad packets from the packet test 
• Total number of neighbors 
• List of neighbors for the device 

The following reports are available: 

• All devices sorted by node ID 
This report will list all of your Z-Wave devices sorted the Z-Wave node ID 

• All devices sorted by location 
This report will list all of your Z-Wave devices sorted by their location 

• All devices sorted by test time 
This report will list all of your Z-Wave devices sorted by the time it took to run the 
packet test. You must run the packet test first before running this report. The nodes with 
the slowest response are listed last. 

 

License 

By default, Z-Seer will run as trial for 30 days. During the trial, it will analyze up to 4 nodes. A 
license may be purchased from the HomeSeer online store at www.homeseer.com. 



After purchasing a license ID and password will be issued. Select Register License from the Help 
menu to bring up the license dialog. Enter the License ID and password as issued then click the 
Register button. Your computer must be connected to the Internet to complete the registration 
process. 

If your computer is not connected to the Internet, you may still register the software. Contact us 
by phone or open a help desk ticket and enter the Code 1 and Code 2 displayed on the dialog. To 
display Code 1 and Code 2, click on Manual Registration. HomeSeer will issue you a registration 
code that you enter into the dialog. Click the Register button to complete the process. 

  

 

Analyzing Results 

While Z-Seer can give you a lot of information about your Z-Wave installation, the information 
is useless if you don't understand what its telling you. Some background information on how Z-
Wave works will help in analyzing the results. 

Z-Wave uses packets of data to communicate between devices. Most communication is done 
between the controller and the device (node). Normally packets are sent to the node directly. In 
some cases, the node may be out of range of the controller. Z-Wave specifications show a max 
range of 100 feet. However, walls, furniture, appliances, etc. will greatly affect this range. To 
overcome this issue each Z-Wave device can act as a radio frequency repeater. But rather then 
blindly repeating the signal everywhere, the packet of data is routed to its destination. How is 
this done? Each device can detect which other devices are within its range. It then relays this 
information back to the controller. The controller can build a routing table since it knows which 
devices can see who. If it needs to send a command to device C, but it cannot reach it directly, 
but it knows device B can talk to C, and itself can talk to B, then it routes the packet through B to 
get to C. This routing is all done automatically. However, its reliability depends on all nodes 
having a reliable list of neighbors. This neighbor list is created when the device is added to the 
primary controller (the Z-Troller for example). It does not update automatically. If the device is 



unplugged and moved to a new location, the neigbor list is no longer accurate. Ideally, the device 
should be deleted from the controller and re-added. This is less then optimal considering the 
device may have been added to many events in HomeSeer, and removing it will remove it from 
all events. Z-Seer overcomes this issue by allowing you to force the node to re-discover its 
neighbors. This is the Optimize button on the main screen, or right click on a node to re-discover 
the neighbors for that single node. 

Now that we have a better understanding on how Z-Wave works, we can better understand the 
results Z-Seer is giving us. The most important function of Z-Seer has is the Test All function. 
This test will test connectivity between the controller and each node. By default, the test will 
send 10 packets to each node and record the total time as well as good and bad packets. If all 
your nodes can communicate with the controller directly (without routing), your test times will 
typically be less than one second for each node. One or two seconds is typical if packets need to 
route. Test times of over 10 seconds may indicate a problem. If any bad packets are displayed, 
then some investigation needs to be done. There should not be any bad packets as this indicates 
that a node is not communicating reliably. The next section lists some error conditions and ways 
to troubleshoot the problem. 

Observation What to do 
After running the Test All function, I see 
a node (or nodes) with the bad packet 
count equal to the total number of 
packets that were sent 

If the test was set to send 10 packets and you 
see 10 bad packets, this indicates that the 
controller was not able to communicate with 
the node at all. Most likely, HomeSeer is not 
able to send commands to this node. The node 
is either totally out of range of any other node, 
its not powered on, or it has a hardware failure. 
If the node is a motion sensor, the sensor is 
most likely sleeping and is not listening for 
commands. This is normal. Right click on this 
node and select "Exclude from Test All" so its 
not tested. To test it, check the instructions for 
the device to see how to keep the senor awake. 
The ZIR000 motion sensor will stay awake for 
10 minutes after you first insert the batteries. 
You can then run a test on it during this time 

Before assuming that this node is bad or out of 
range, click the Optimize button on the main 
screen to force all nodes to re-discover their 
neighbors. Execute this at least 2 times. Re-run 
the Test All function again and see if the node 
now replies. You can also right click on the 
node and just test that one node. If you want a 
battery powered device to re-discover its 
neighbors, then you must make sure its awake. 

If the node can be controlled with a remote, 
then the issue is not a hardware failure and 
most likely is a range issue. Try installing 
another Z-Wave device between one of its 
neighbors and itself. A plug-in lamp module is 



great for this purpose. Hover your mouse over 
the node to see all its neighbors (they will 
display as green). 

After running the Test All function a 
node (or nodes) have some bad packets 

This indicates that while the node can be 
contacted, connectivity is not 100% reliable. 
This is most likely due to the device being out 
of range of its neighbors. Try the Optimize 
button on the main screen, then re-run the test. 
If you still see bad packets, try installing 
another Z-Wave device, like a plug-in lamp 
module between one of its neighbors and itself. 
If Z-Seer is showing many neighbors for this 
device, then the device itself may have a 
hardware problem. 

Some of my devices only have one 
neighbor 

While not necessarily a problem, it may point 
to issues in the future. In the ideal installation, 
all nodes should see all other nodes. Obviously, 
this cannot happen in larger homes since walls 
and other obstructions will limit the RF range. 
However, its best that each device have 
multiple neighbors. This allows the controller 
to have multiple paths to the destination. You 
may need to install more Z-Wave devices in 
order to provide more neighbors for the device 
in question. 

It appears that the controller is routing to 
all my devices 

After running the Test All function, you see 
times of 2 seconds or more for all your devices, 
this indicates that the controller is probably 
routing to all devices. This is not really a 
problem as Z-Wave will route through up to 4 
nodes. However, it may slow down HomeSeer's 
ability to send many commands at once. There 
has to be at least one node that the controller 
can contact directly. Check all the test times 
and find the node that has the lowest time 
(normally less than a second). This is probably 
the node that the controller is routing all 
commands through. If this node was ever 
removed or powered off, your entire Z-Wave 
network may stop working. You might try re-
positioning the controller so it can directly 
contact more devices.  
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